NVivo: 11Pro - Getting Started
Qualitative Data Analysis

Course objectives:
Making content into data
- Gather sources and import content
- Understand coding nodes and cases
- Work with memos, annotations and links
- Explore and analyse data
- Use Visualisation tools

Student Training and Support
Phone: (07) 334 64312
Email: askus@library.uq.edu.au
Web: https://web.library.uq.edu.au/library-services/training/

Service Points
St Lucia: Main desk of the SSAH, ARMUS and DHESL libraries
Hospitals: Main desk of the PACE, Herston and Mater libraries
Gatton: Level 2, UQ Gatton Library

Staff Training (Bookings)
Phone (07) 3365 2666
Email staffdev@uq.edu.au
Web http://www.uq.edu.au/staffdevelopment

Staff may contact their trainer with enquiries and feedback related to training content. Please contact Staff Development for booking enquiries or your local I.T. support for general technical enquiries.
# Table of Contents

**NVIVO: 11Pro** ......................................................................................................................................................................................................................................................... 3
  Exercise 1. Access NVIVO ........................................................................................................................................................................................................................................ 3

**Getting Started** ......................................................................................................................................................................................................................................................... 3
  Exercise 2. Create a new project ...................................................................................................................................................................................................................... 3

**The NVIVO interface** .............................................................................................................................................................................................................................................. 4
  Exercise 3. Building a Mind Map .................................................................................................................................................................................................... 4
  Exercise 4. Open a project ............................................................................................................................................................................................................. 6
  Exercise 5. Nodes from a Mindmap ................................................................................................................................................................................................... 7
  Exercise 6. Add file structure ....................................................................................................................................................................................................... 8

**Working with Data** ........................................................................................................................................................................................................................................... 8
  Exercise 7. Prepare Content ........................................................................................................................................................................................................ 8
  Exercise 8. Import Content ......................................................................................................................................................................................................... 8

**Coding Nodes and Cases** ..................................................................................................................................................................................................................................... 12
  Exercise 9. Creating and Coding nodes ........................................................................................................................................................................................ 12
  Exercise 10. Display Coding ................................................................................................................................................................................................... 13
  Exercise 11. Coding to existing nodes ..................................................................................................................................................................................... 13
  Exercise 12. View Image Coding .......................................................................................................................................................................................... 14
  Exercise 13. Auto Coding – Nodes ....................................................................................................................................................................................... 15
  Exercise 14. View Node References ................................................................................................................................................................................... 16
  Exercise 15. Merge Nodes ........................................................................................................................................................................................................ 16
  Exercise 16. Auto coding - Cases ......................................................................................................................................................................................... 17
  Exercise 17. Survey results and other datasets ......................................................................................................................................................... 18

**Querying Data** ........................................................................................................................................................................................................................................... 21
  Exercise 18. Create a Matrix Coding Query ................................................................................................................................................................. 21
  Exercise 19. ‘Word Frequency’ Query .............................................................................................................................................................................. 22
  Exercise 20. Create a Word Query ..................................................................................................................................................................................... 24
  Exercise 21. Create a Coding Query ............................................................................................................................................................................... 25

**Visualisation Tools** ........................................................................................................................................................................................................................................ 26
  Exercise 22. Diagrams ......................................................................................................................................................................................................... 26

**Memos, annotations and links** ...................................................................................................................................................................................................................... 29
  Exercise 23. Create a Memo .................................................................................................................................................................................................... 29
  Exercise 24. Link a Memo ..................................................................................................................................................................................................... 29
  Exercise 25. Annotations ..................................................................................................................................................................................................... 30
  Exercise 26. Adding a “see also” link ..................................................................................................................................................................................... 31

**Extension Exercises** ...................................................................................................................................................................................................................................... 32
  Exercise 27. Import content with NCapture ................................................................................................................................................................. 32
  Exercise 28. Add ‘case’ classifications .............................................................................................................................................................................. 35
  Exercise 29. Work with Classification Sheets ............................................................................................................................................................... 36
  Exercise 30. Add ‘source’ classifications ................................................................................................................................................................. 36

**Exercise files:** Go to [https://web.library.uq.edu.au/library-services/training/training-resources](https://web.library.uq.edu.au/library-services/training/training-resources)
**NVIVO: 11Pro**

NVivo is designed to facilitate common qualitative techniques for organising, analysing and sharing data in a research project. NVivo can help you manage, explore and discover patterns in your data but it cannot replace your analytical expertise.

### Exercise 1. **Access NVIVO**

NVivo is accessed via Zenworks in the University of Queensland library.

1. Go to Zenworks application
   This window will be found on the workstation desktop.
2. Open **On this PC**

3. Double-click the **Nvivo 11 icon**

4. Complete profile details, if prompted
5. Add your initials.
   These will be used to identify your edits as you progress
6. Click on **OK**

During your session you will receive on-screen prompts to save your progress

### Getting Started

### Exercise 2. **Create a new project**

1. Click on the **Blank project** option

2. Complete project details
3. Click **Browse** to save project to your preferred location.
   **Note:** If you are collaborating with other users it is advisable to tick the checkbox to **Write user actions to project event log**
4. Click on **OK**
The NVIVO interface

Exercise 3. Building a Mind Map

When considering topics that may be present in your data you can create a mind map to visually explore potential concepts. These can be used as a brainstorming tool for Planning your node hierarchy, during analysis to explore how people talk about a topic or to plan how you will tell the story of your research.

a. Create a Mind map

1. Click on Mind Map on the Explore tab

2. Enter a Name: Mind Map Intro

3. Add a Description (Optional)

4. Click on OK

A new tab for Mind Map tools will appear in the ribbon
5. Double click map **Core Idea** to enter text
   “Early thoughts on coding”

6. Click on **Child Idea** button

7. Add the text **Economy**

8. **Repeat** for **Real Estate Development**

9. Click on the **Sibling Idea** button

10. Add the text **Fishing**

11. Continue to create the Mind Map as shown:
    - **Select Fishing:** Add **Child** = Commercial Fishing
    - **Select Commercial Fishing** Add **Sibling** = Recreational Fishing
    - **Select core object:** Add **Child** = Natural Environment
    - **Select Natural Environment:** Add **Child** = Water Quality
    - **Select Water quality:** Add **Sibling** = Habitat
    - Add **Sibling** = Landscape

1. Click the **Floating Idea** Button on the Mind Map tab

2. Add the text **Community Culture**
3. Click on the Fill button
4. Click on the Border Colour button
5. Click on the Border Width button
6. Select a wider border for the idea object

7. Select a layout for the Mind Map in the ribbon

b. Mind Map Output
1. Right click in mind map area
2. Select Export Map
   Alternatively
   • Click Items on the DATA tab
3. Enter details to save Mind Map as a static image
4. Click on Save
5. Click on File in ribbon
6. Select Close
   Save project if prompted

Exercise 4. **Open a project**
A standalone project is a .nvp file saved on your computer or on a network drive.

1. Click the File tab
2. Click Open.

**Note:** Ensure NVivo Projects from the File or Project type list is displayed
3. Locate and select project you want to open.
4. Click Open.
Exercise 5. Nodes from a Mindmap

a. Create Nodes from a mindmap

1. Open Training Project 1
2. Go to Maps
3. Double click MindMap Intro
4. Click Create as Nodes
5. Select the Nodes folder
6. Click on OK
7. Click on Nodes in Navigation view
   Empty nodes are created based on the Mind Map structure.

b. Edit Nodes - Nodes can be deleted or re-arranged. If a parent node is to be deleted but the child nodes retained, the child nodes need to be allocated a new parent node in the first instance.

1. Click on Economy node
2. Hold Ctrl and Click on Natural environment node
3. Drag these selected nodes over the Nodes folder in Navigation View
4. Right click on the Early thoughts on coding node
5. Select Delete
6. Click on Yes to confirm deletion
Exercise 6.  

Add file structure

1. Navigate to Sources
2. Right Click Internals
3. Select New Folder
4. Enter Interviews
5. Repeat for Survey Data

Working with Data

Exercise 7.  

Prepare Content

This exercise uses Microsoft word and is preparation of data prior to importing into a project although styles can be added to a document within NVivo

1. Open Barbara.docx in Interviews folder
2. Apply heading styles to the Interview text:
   - Heading 1 – Question 1
   - Heading 2 – Names (Henry and Barbara)
   - Interviewer – Questions asked
3. Save and Close Barbara.docx

Adding styles to your text in Microsoft word can improve how it is coded in NVivo

Exercise 8.  

Import Content

a. Bring in a document
   1. Select Internals
   2. Click the Data tab
   3. Click the Documents button
   4. Select All interviews in interviews folder
5. Click on OK

6. Click on OK in the Document Properties window, if required

Note: Your file is added to the internal sources folder

7. Doubleclick an interviewee to view content
   As you access each source it will display in a tab of its own in the detail view pane. Click the cross to close a tab

8. Select all interviews in Internals under Sources
9. Drag into the interview folder

b. Bring in a PDF

1. Select Internals
2. Click the Data tab
3. Click the PDF button
4. Navigate to the Other Data folder
5. Double click Sea Grant Fact Sheet.pdf
6. Click on OK

7. Click on OK in the Document Properties window, if required

The PDF is added to the list of sources
c. Bring in images

1. Select Internals
2. Click the Data tab
3. Click the Pictures button
4. Navigate to the Other Data folder
5. Select Barrier Islands and Cape Lookout
6. Click on Open
7. Click on OK
8. Click on OK in the Document Properties window, if required

The image is added to the list of sources

d. Bring in Audio

A video or audio source consists of a media file and a transcript. The transcript can be manually added, automatically created or purchased via NVivo and Transcribe.

1. Select the destination folder in Internals (interviews)
2. Click Audios on the data tab
3. Navigate to the audio file Helen in Media Data
4. Click on open
5. Click on OK
6. Go to the Audio tab
   Ensure Embedded in project is selected. This should be the default setting
7. Click on OK

The audio file will be added to the list of internal interview sources
Transcribe audio for coding

1. Double click the file to open in details view
2. Click on Click to edit
   This will open the audio log for transcription
3. Use the playback tools on the media tab
4. Click to enter timespan
5. Add 0-10
6. Click next cell to enter transcript
7. Add “Interviewer Question”

Anything you transcribe will be automatically saved to the project. You can also import a transcript or purchase one from NVivo. As at Aug 2017 the cost per minute is $2.25 USD

Import Transcript for coding

1. Click Documents on the DATA tab
2. Select Helen Transcript in the Media Data folder
3. Click on Open
4. Click on Ok
Coding Nodes and Cases
Coding allows you to organize your sources for later data analysis. Applying coding to your content will organise text into certain nodes/containers. This is the start of the process to make your content into data. There are two approaches to coding source content

1. Organise the data into broad topics then explore your nodes for each topic and do further coding
2. Perform detailed coding as you go through sources, creating nodes as you need them and later combining or grouping nodes into related categories.

Exercise 9.

Creating and Coding nodes

a. Code data manually

1. Double click to view the details of an interview (Barbara)
2. Highlight a line of text
3. Right click the selection
4. Select Code
5. Alternatively
6. Click Code on the ANALYZE tab
7. Click the New Node button
8. Enter a name for the node ‘Years in Town’
9. Click on OK

Check the list of internal sources. Coding has been added to the first interview

10. Repeat for another line of text
11. Add to the ‘Years in Town’ node
Check the list of internal sources.
12. Navigate to Nodes
13. Open another interview (Charles)
14. Select text
15. Drag over node ‘Years in town’
16. Repeat for other interviews
Exercise 10. **Display Coding**

This setting only applies to the data currently in view. It is not a global setting and will have to be switched on/off, as required, for every coded source opened.

1. Go to the View Tab
2. Click on Coding Stripes
3. Select Nodes Recently Coding

The coding density will display and the node will show with a bar to identify each reference. Click on the coding stripe to highlight your coding in the document.

a. **Remove code**

1. Right click on a coding stripe
2. Select Uncode

b. **Remove highlight**

3. Go to the View Tab
4. Click on the Highlight button
5. Select None

Exercise 11. **Coding to existing nodes**

a. **Code documents**

1. Navigate to Sources
2. Open Helen’s transcript
3. Select “she doesn’t want to sacrifice the environment to gain affordable housing”
4. Right click on selected text
5. Select Code...
6. Hold Ctrl to select nodes
   - Community Culture
   - Real estate Development
   - Natural Environment

7. Click on OK

Check the Node hierarchy, coding has been added to the appropriate nodes

8. Repeat for other transcript paragraphs

b. **Code PDFs**

   Be careful with PDF’s. If the file has been created as an image coding specific content will not be possible.

   1. Goto Sources
   2. Open the PDF
   3. Highlight a paragraph

   4. Navigate to Nodes to display Hierarchy
   5. Drag and drop paragraph over **water quality** node

c. **Code Images**

   1. Go to Sources
   2. Open the image
   3. Click and drag across a part of the image

   4. Navigate to Nodes to display Hierarchy
   5. Drag and drop selection over **Natural Environment** node

---

**Exercise 12.  View Image Coding**

1. Go to Nodes
2. Double Click to open **Natural Environment**
3. Click link to image **Barrier Island and Cape Lookout**

   The image coding reference will be pixel co-ordinates:
   starts at 330x270y and ends at 620x480y
4. The coded section will appear as inverted/shaded

Exercise 13.  

Auto Coding – Nodes

a. Based on structure
Autocoding by structure works based on styles, and the use of consistent use of styles is critical. In the sample data each question has the Heading 1 style applied and each speaker has the heading 2 style applied. These styles were applied via Microsoft word and the interviews can be viewed either in Nvivo or in Word.

1. Navigate to Sources
2. Select all the interviews in internals
3. Go to the Analyze tab
4. Click on Auto Code
5. Click on the style to be coded - Heading 1
6. Click the >> arrows to transfer right
7. Click on Next
8. Click the Under field
9. Select New Folder
10. Add a name - Interview Questions
11. Click on Finish
Exercise 14.  

**View Node References**

1. Click **Nodes** in the Navigation view  
   Double-click Nodes to expand if necessary

2. Click on **Interview Questions**  
   References will be displayed in detail view

3. Double click on a question node  
   Content will be displayed in the Details View

4. Click on the link at the top of each reference to open the source

5. Scroll through the node questions to see the other coded source content

Exercise 15.  

**Merge Nodes**

1. Right click on the last question in **Nodes/Interview Questions**
2. Select **Cut**

3. Right click on the last Q.6.
4. Select **Merge into Selected Node**

5. Click on **OK**

Check the sources and references totals have been merged
Working with Cases

Exercise 16. Auto coding - Cases

Cases are simply a different type of Node. Cases can help keep all data related to a given participant in one place. eg If you are doing a longitudinal study or are working with demographic data.

1. Select all the interviews in internals
2. Go to the Analyze tab
3. Click on Auto Code

4. Click on Heading 1
5. Click the << arrows to transfer left
6. Click on the style to be coded - Heading 2
7. Click the >> arrows to transfer right
8. Click on Next

9. Click the Under field
10. Select Existing Folder
11. Click on Select...
12. Select Cases
13. Click on OK
14. Click on Finish

b. Case organisation - Parent Node

Autocoding will include the interviewers in the
1. Navigate to Cases in Nodes
2. Right click below list of case names
3. Select New Case

4. Add name – Interviewer
5. Repeat steps 1-3 for Interviewee
6. Click on the marker alongside **Henry**
7. Drag over **Interviewer**
8. Repeat for **Nancy, Linda and Elizabeth**
9. Click on a name
10. Hold CTRL and click on another name
11. Drag selection over Interviewee

C. **Aggregation of data**

1. Right click on the **Interviewer case**
2. Select **Aggregate coding from child nodes**
The totals for child sources and references will be displayed.
3. Repeat for the **Interviewee case**
   This is a toggle option repeat to hide aggregation.

---

**Exercise 17. Survey results and other datasets**

⚠️ You **cannot** edit the contents of a dataset once it is imported

A dataset contains structured data arranged in columns and rows. One method of creating a new dataset in NVIVO is to import it from a spreadsheet, text file or database file.

a. **Bring in survey data**

1. Click on the **Survey** button on the Data tab
2. Select a survey.xlsx
3. Click on **Open**
4. Confirm the survey wizard settings:
   a. Respondents will be cases
   b. Closed questions have attributes
   c. Open questions are nodes
5. Click on Next

6. Check and confirm:
   - The worksheet tab for data
   - Question headers
   - Date format
7. Click on Next

8. Confirm location
9. Indicate the column for a unique identifier for each item
10. Select Create new classification
11. Click on Next

12. Identify data questions
13. Click on Finish
Survey import results should all be checked

14. Click on Close to display data in details view

Data will display as an internal source and in list view
You cannot sort or filter by the first column. This is NVIVO’s own added reference.
Grey shaded columns are closed ended questions (Classifying data)
White shaded columns are open ended responses (Codable data)

Survey data can be viewed in a table or by individual forms

15. Select the appropriate tab to change the view

b. Viewing imported Survey Dataset

1. Click on Nodes in Navigation Pane
2. Select Survey Data
3. Each participant will have a case and a unique identifier
4. Double click the first node to display references in Detail view
   Remember each Node will open in a new tab
Querying Data

Exercise 18. Create a Matrix Coding Query

Matrix coding query can easily compare coded material across different demographics or among themes. This can help you see patterns in your data and help you answer questions about your research. We can look at the intersect between nodes and classification attributes.

a. New Matrix – Do different genders view development differently?

1. Click Matrix Coding on the query tab
   The New Matrix dialog box opens

2. Click the checkbox Add to Project
3. Enter a name Matrix 1
4. OPTIONAL enter a description

5. Click on the Matrix Coding Criteria tab
6. Click the Select... button on the Rows tab
   Create a row for each gender value - Female & Male only
7. Select the case classifications
8. In survey respondents, expand to view Gender attributes
9. Select Male and Female
   Case nodes represent attributes for people or places in the content

10. Click on OK
11. Click on the Add to list button
12. Click the Column tab
13. Click the Select... button
14. Select the theme nodes for the Survey Data to cross tabulate in your matrix.
   Theme nodes represent coded text in the content
   Nodes > Survey Data > Select three questions
15. Click on **OK**
16. Click on the **Add to list** button

17. Go to **Query Options** tab
18. Click Option field
19. Select **Create Results as New Node Matrix**
20. Change **Location** to **Node Matrices**
21. Add **name:** *Matrix1-gender feedback*
22. Click on **Run**
   If you click **OK** you don’t actually query the data.

23. You can run the query anytime from **Node Matrices** in the Navigation view pane.

24. Double click **matrix1** result to see content

b. **Viewing and amending matrix results**

1. Click **Node Matrices** on the **View** tab
2. Select **Words Coded**

   The number of words coded by each gender for each question will be displayed.

3. Double click on any number to see the coded references

---

### Exercise 19.  

**‘Word Frequency’ Query**

Provides an idea of potential trends at a high level.

1. Go to **Query** tab
2. Click on **Word Frequency**
3. Set parameters for query
   
   **Search:** All sources
   
   **Display:** 50 most frequent words
   
   **Minimum length:** 3

4. Click on Run Query
   
   The results will be displayed. Nvivo has a built in filter to avoid filler words like it, is and that.

5. Click on Add to Project for future use
   
   a. **Exclude words in query**
      
      1. Right click on east in results list
      2. Select Add to Stop Words list
      3. Click on OK
      4. Re-run the query

   b. **Automatic word grouping**
      
      1. Change grouping to With stemmed words
      2. Re-run the query

   c. **Add query to project for reuse**
      
      1. Click the Add to project button
      2. Enter a name for the query
      3. Click on OK
      4. Navigate to Queries and view saved project queries
      
      **This is not the results, only the query settings**
Exercise 20. Create a Word Query

1. Click on the **Word Cloud** tab, below the **Summary**, at the right of the results list

2. Go to the **Word Cloud** tab
3. Select an alternative design

4. Right click on **Word Cloud**
5. Select **Export Word Cloud**
6. Enter a **filename**
7. Click on **Save**
   You will have a static image of the word cloud generated from your text query

   a. **Single word query**

1. In the word cloud, right click on the word “Waters”
2. Select **Run Text Search Query for waters**

3. Click on the **Reference** tab to see waters with more context
4. Click on the **Word Tree** tab.

   The word tree groups together words which appear frequently before and after the word water
b. Word tree query

1. In the Word tree, right click on the word “Quality”
2. Select Run Text Search Query
3. Click on the Summary tab to see where water quality is mentioned in the interviews
4. Click the Reference tab for more context
5. Click on the Word Tree tab to see a new word tree
6. Click on Save Results...
7. Enter a name
8. Click on OK

Be aware the word tree is not retained when you choose Save Results... To display the word tree you have to re-run the query

Exercise 21.  

Create a Coding Query

Query our data to discover whether our coding presents any overlap between interviews and water quality

1. Click Coding on the Query tab
2. Select Selected Items...
3. Select Interviews in internals
4. Click on OK
5. Confirm Settings:
   Any of the following are true
   Coded at Any Selected Nodes
6. Click the Ellipsis button
7. Select Water Quality in nodes
8. Click on OK
9. Click **Run Query**  
Results may be displayed

10. Click **Save Results**... to keep a copy of results in the project

A message presents indicating there are no results.  
Change query settings or add coding before running query again.

11. Click **Add to project**... to save the query settings

If no results appear it might mean no coding exists at that point in time.  
This might indicate further coding may be required for the query to return data successfully.

**Visualisation Tools**

**Exercise 22.**

**Diagrams**

a. **Explore diagram**

1. Select a source node or case  
   *(Dorothy)*

2. Click **Explore Diagram** on the Explore tab

The diagram appears in details view
3. Click on a surrounding item
4. Click the **Change Focus** button
   Use the ribbon to see more connections

5. Click the **back** button to navigate through the diagram
6. Double click any item to view its content

7. An explore diagram is NOT stored as part of a project. To save the diagram
   
   - Copy and paste into a memo
     a. **Click and drag across image to select all elements**
     b. **Copy**: ctrl C
     c. **Click Memo** on Create tab
     d. **Add a new memo name**
     e. **click OK**
     f. **Paste**: ctrl V

   - Export as an image
     a. **Right click on diagram**
     b. **Select Export Diagram**
     c. **Navigate to a location**
     d. **Click on Save**

b. **Comparison diagram**
   A comparison diagram lets you compare two of the same type of project items, sources, nodes or cases. The comparison indicates the similarities and differences between items.

1. **Click Comparison Diagram** on the **Explore** tab
2. **Select Compare Cases**
3. Select 2 interview participants

4. Click on OK

The comparison diagram opens in detail view.

Everyting items have in common is in the centre of the diagram. Links to item differences are shown either side of the diagram.

5. Double Click any item to open and view content

Use the tools on the Ribbon to show links you are interested in.

6. An comparison diagram is NOT stored as part of a project. To save the diagram

   - Copy and paste into a memo
     a. Click and drag across image to select all elements
     b. Copy: ctrl C
     c. Click Memo on Create tab
     d. Add a new memo name
     e. Click OK
     f. Paste: ctrl V

   - Export as an image
     a. Right click on diagram
     b. Select Export Diagram
     c. Navigate to a location
     d. Click on Save
Memos, annotations and links

Memos are an integral part of the research process. They are like documents or notes that can be linked to other sources or nodes. A memo can be about the entire project or it can link to a specific node or item. Annotations in NVIVO are like notes in the margin. See Also Links can be used as cross references between related items in your project.

Exercise 23. Create a Memo

1. Click on Memo on the Create Tab

2. Enter a Name – Couple1

3. Click on OK

4. Enter any notes relating to your source

5. Click Close cross on memo tab.

NVivo will automatically save whatever you type.

6. Go to Memos in Sources

The new memo will be displayed in list view.

Exercise 24. Link a Memo

To link memos to a source item, go to the source item first. Memos can only be linked to a single source item. Anything already linked will be unavailable.

1. Go to Internals in Sources

2. Click on Maria and Daniel in interviews

3. Click the Analyze tab

4. Click the Memo Link button

5. Select Link to Existing Memo

6. Select the Couple1 memo.

7. Click on OK
Exercise 25.  

Annotations

Annotations are like margin notes you can record comments, reminders or observations. These will display with a blue highlight in the text.

a. Create an Annotation

1. Open a Source interview
2. Select text to annotate
3. Go to the ANALYZE Tab
4. Click the New Annotation button
   A number is added at the bottom of the screen for your annotation. Click on this number to navigate to the annotation.
5. Start typing your annotation
6. Click into the source content when complete
   Annotated text is highlighted in blue

b. Edit annotations

1. To see all annotations in a project click Annotations under Collections
2. In Sources: Doble click to open a source
3. Select Click to Edit
4. In Nodes: Double click to open a node
   All nodes added to sources will be visible and annotation editing is activated automatically
Exercise 26.  

Adding a “see also” link

A ‘see also’ link is like a cross reference to connect items in an NVivo project. These will display with a pink highlight in the text.

a. Link to an existing source

1. Select text to link from
2. Click See Also Link on the ANALYZE tab
3. Click New See Also Link...
4. Click the Select button.
5. Navigate to the source item
6. Select the item
7. Click on OK
8. Click on OK

The “See Also” link will be added and link text will be pink

b. Go to See Also links – in Collections

1. Right click on the link details
2. Select Open to Item
   (Link Destination)

   Alternatively:

3. Select Open from Item
   (where link was created)
4. Click the reference link to open the source.
Extension Exercises

NCapture for web sources.
NCapture is a tool which allows users to capture web content including web pages, social media and video/audio clips.

Exercise 27. Import content with NCapture

To use the NCapture tool you have to first of all add the extension to your browser.

a. Install NCapture extension to browser (Google Chrome)

1. Search in the browser “NCapture Google Chrome”
2. Click the link to the Google Web Store

Check the extension available is offered by QSR International
3. Click “+ ADD TO CHROME”

4. Click Add extension
A confirmation pop up may display. You can now capture web content for your NVivo project.

b. Capture web content

1. Navigate to a web source: http://abc.net.au
2. Open any article
3. Click the NCapture icon on the address line

4. Select Source type: Article as PDF
This may not be successful with sites that contain dynamic data which automatically updates. You may need to use WebPage as PDF but be aware this will include all content including ads.
5. OPTIONAL: Add a description
6. OPTIONAL: Code at Node
Add Node names for auto coding (New or existing)
7. Click on Capture
c. **Capture social media content**

1. Navigate to a twitter feed: [twitter.com/UQ_News](http://twitter.com/UQ_News)
2. Click the NCapture icon on the addressline

3. Select Source type: **Tweets as Dataset including Retweets**
4. OPTIONAL: Add a description
5. OPTIONAL: Code at Node
   
   *Add Node names for auto coding (New or existing)*

6. Click on **Capture**

   You may be asked to authorise NCapture to use your account

7. Click on **Authorize app**
   
   You’ll be returned to the twitter page.

8. Click on **Capture**
   
   This can capture up to 5000 tweets

The article will be converted to a .nvcx file

d. **Capture media clip content**

1. Navigate to youtube: [http://youtube.com](http://youtube.com)
2. Go to an appropriate media clip
   
   [https://www.youtube.com/watch?v=DqDaZNyUKOg](https://www.youtube.com/watch?v=DqDaZNyUKOg)

3. Click the NCapture icon on the addressline
4. Select Source type: Video only
5. OPTIONAL: Add a description
6. OPTIONAL: Code at Node
   Add Node names for auto coding (New or existing)
7. Click on Capture

Confirmation of the capture will be displayed

The media clip will be converted to a .nvcx file

e. Import NCapture content
   1. Open NVivo project
   2. Navigate to Internals in Sources
   3. Click From Other Sources on the DATA tab
   4. Select From NCapture...

   5. Browse to locate captures folders, if necessary
   6. Click Selected Captures
   7. Select the captures to be imported
   8. Click on the Import button

   9. Navigate to Internals in Sources
   The imported content will be available.
Understanding Classifications

Classifications are necessary to allow for reliable querying of data. They store information about your participants and sources. They provide a way to record descriptive information about the sources, nodes and relationships in your project. Think of this as a way of creating a database of imported content to help analyse it further. You can only have one classification applied to a node or source at any time.

This is a three step process –
1. Create a classification,
2. Add attributes to it with values
3. Add sources into the classification.

Exercise 28. Add ‘case’ classifications

a. Create case classification
   1. Navigate to Classifications
   2. Go to Case Classifications
   3. Right click in List view
   4. Select New classification

   5. Add a name: Residents
   6. Click on OK

b. Add attributes
   1. Click on Residents classification
   2. Click on Attribute on the Create tab

   3. Add an attribute name (Age group)
   4. Go to the Values tab
   5. Click on the Add button
   6. Enter Over 50 attribute value
   7. Click on the Add button
   8. Repeat for Under 50
   9. Click on OK
10. Repeat above to add a new attribute (Gender)
11. Add the values Male and Female

c. **Add cases to classification**
   1. Navigate to Nodes
   2. Go to Cases in Nodes
   3. Select all interviewees cases
   4. Right click on selection
   5. Hover over Classification
   6. Select classification: Residents
   The data will be classified to attributes but will have no values associated yet.

**Exercise 29. Work with Classification Sheets**

When you have classified your sources or cases, you can open a grid that displays the attributes for all items in a particular classification—this grid is called a classification sheet.

1. Click on Case Classification Sheets on the EXPLORE tab
2. Select Residents
   Each participant is represented by a row and attributes are displayed in each column.
3. Assign a gender to each interviewee
4. Assign an age group to each interviewee

**Exercise 30. Add ‘source’ classifications**

a. **Create source classifications:**
   
   *A source can only be in one classification at a time*

   1. Navigate to Classifications
   2. Go to Source Classifications
   3. Click Source Classification on the CREATE tab
4. Select **Add one or more predefined classifications to the project**

5. Click the checkboxes for the classifications to add:
   - Artwork,
   - Book,
   - Electronic Book, Grant &
   - Interview

6. Click on OK

   The new classification for Sources will appear.

**b. Apply to sources**

1. Navigate to **Sources**
2. Go to **interviews** in **internals**
3. Select all interviews
4. Right click on selected interviews
5. Hover over Classification
6. Select classification: **Interview**

**c. View source classifications**

1. Click on **Source Classification Sheets** on the **Explore** tab
2. Select **Interviews**

   The interviewees will be listed under this classification

**d. Modify Attributes**

1. Navigate to **Classifications**
2. Select **Source Classifications**
3. Expand the **Interview** classification
4. Double click on **Interviewer**
5. Click the **Values** tab
6. Click the **Add** button
7. Enter **Henry**
8. Repeat for **Nancy**
9. Click the default checkbox alongside **Henry**
10. Click on **Apply**
11. Click on **OK**